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Introduction 

PreK Curriculum: Alignment is a practical planning companion that maps each lesson to 
nine widely used early-childhood frameworks so teachers, coaches, and administrators 
can plan consistently while honoring program philosophy and local standards. The guide 
centers whole-child learning, culturally responsive practice, and developmentally 
appropriate experiences for three- to five-year-olds. 

Purpose 

• Show clear, cross-framework connections for each lesson so it “fits” Montessori, 
Reggio Emilia, HighScope, Creative Curriculum, Bank Street, Emergent Curriculum, 
Waldorf, Project-Based Learning, and Academic/Skills-Based models. 

• Support equitable, inclusive instruction by highlighting identity, community, and 
empathy across content areas. 

• Provide concise, observable objectives and alignments that make walkthroughs, 
coaching, and documentation straightforward. 

What’s inside 

• Lesson header with a clear title. 

• 3–5 objectives starting with action verbs and written for observable behaviors. 

• Nine curriculum models listed in a consistent order, each with 2–3 alignment 
points formatted as: Standard/Area → How lesson connects. 

• Optional extensions, observation look-fors, and book lists in companion sections. 

How to use this guide 

1. Start with objectives to define success criteria for children’s learning that day. 

2. Locate your program’s framework and apply the aligned bullets directly to planning 
notes. 

3. Use additional models to differentiate or communicate alignment across mixed-
philosophy teams. 

4. Copy alignment language into lesson plans, newsletters, or coaching tools for 
evidence of rigor and coherence. 

5. During/after the lesson, reference the objectives and look-fors for quick formative 
assessment. 
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Equity & inclusion commitments 

• Lessons are written through an anti-bias, culturally sustaining lens with age-
appropriate language and emphasis on kindness, fairness, and belonging. 

• Universal Design for Learning (UDL) principles are embedded—multiple ways to 
engage, represent content, and express learning. 

• Family voice and community knowledge are valued; activities invite caregivers to 
contribute stories, languages, and traditions. 

Assessment & documentation 

• Prioritize observational notes, photos of process, and child voice (dictation). 

• Use checklists to capture growth in language, SEL, and problem-solving; avoid 
comparative labeling. 

• Reflect as a team on what to revisit, extend, or adapt. 

Adaptation & implementation notes 

• Adjust materials to reflect your community’s cultures and home languages. 

• Offer alternatives for sensory needs and ensure spaces, visuals, and routines are 
accessible. 

• When topics touch on history or identity, keep tone hopeful and concrete, focusing 
on prosocial actions children can take. 

This is a living document. Please annotate margins with what worked, what to refine, and 
family feedback so we can iterate together. 

 

 

 

 

 

 

 

 



Page 3 of 32 
 

©2025 Quarantine Racism Educational Services – All Rights Reserved 

Lesson Title: Celebrating Diversity Through Colors 

Objectives: 

• Recognize and name differences in skin color with respect. 

• Appreciate one’s own and peers’ skin tones to build positive self-esteem. 

• Practice empathy, respect, and inclusivity through discussion and art. 

Curriculum Alignments 

• Montessori: Practical Life/Sensorial → Mirrors & skin-tone crayons support 
observation of self/others. Grace & Courtesy → Guided conversations build empathy. 

• Reggio Emilia: Hundred Languages → Self-portraits express identity and diversity. 
Community as Curriculum → Class gallery displays collective identity. 

• HighScope: KDI 7 Self-Identity → Children describe their skin tones. KDI 8 Diversity 
→ Notice/celebrate similarities and differences. 

• Creative Curriculum: Social Studies—Self, Family, Community → People are 
alike/different. The Arts → Color mixing to represent tones. 

• Bank Street: Emotional Development → Activities promote positive self-image. 
Social Studies Core (Self & Others) → Discuss uniqueness and belonging. 

• Emergent Curriculum: Child-Initiated Inquiry → Children’s comments about color 
guide extensions. Responsive Teaching → Add materials that match interests. 

• Waldorf: Artistic Expression → Gentle portrait work honors beauty of difference. 
Circle Time → Verses/stories affirm dignity. 

• Project-Based Learning: Mini-Project → Collaborative mural of diverse portraits. 
Driving Question → “How do our colors show our uniqueness?” 

• Academic/Skills-Based: Math (Sorting) → Organize crayons by tone. Language → 
Vocabulary (light, dark, tan, brown). SEL → Use respectful language. 
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Lesson Title: Embracing Cultural Clothing 

Objectives: 

• Identify traditional clothing from different cultures. 

• Show respect and curiosity for cultural practices. 

• Celebrate uniqueness through dress-up and discussion. 

Curriculum Alignments 

• Montessori: Practical Life → Care for real garments respectfully. Culture/Geography 
→ Match clothing to regions on maps. 

• Reggio Emilia: Community as Curriculum → Families share clothing stories. 
Hundred Languages → Textile rubbings/collages inspired by prints. 

• HighScope: KDI 8 Diversity → Recognize and respect cultural differences. KDI 7 Self-
Identity → Connect clothing to family identity. 

• Creative Curriculum: Social Studies—People & How They Live → Clothing as 
cultural practice. Dramatic Play → Dress-up for role exploration. 

• Bank Street: Social Studies Core (Community) → Clothing as belonging marker. 
Emotional Development → Practice respectful curiosity. 

• Emergent Curriculum: Child-Led Exploration → Children’s questions shape 
comparisons. Responsive Teaching → Add artifacts per interest. 

• Waldorf: Dramatic Play/Festivals → Role play of traditions with story context. 
Handwork → Simple stitches/fasteners. 

• Project-Based Learning: Mini-Fashion Show → Teams present outfits with facts. 
Driving Question → “What do clothes tell about culture?” 

• Academic/Skills-Based: Math (Patterns) → Sort by prints/shapes. Language → 
Names of garments. SEL → Inclusive comments. 
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Lesson Title: Appreciating Different Hair Textures 

Objectives: 

• Explore and compare hair textures safely and respectfully. 

• Use positive language to value all hair types. 

• Celebrate identity through affirmations and creative expression. 

Curriculum Alignments 

• Montessori: Sensorial → Texture trays/doll hair for tactile exploration. Grace & 
Courtesy → Consent/respect before touching. 

• Reggio Emilia: Hundred Languages → Sculpt/paint hairstyles. Documentation → 
Display “hair stories” and art. 

• HighScope: KDI 25 Physical Properties → Describe textures (curly, coily, straight, 
wavy). KDI 8 Diversity → Recognize varied appearances. 

• Creative Curriculum: Science—Properties → Compare fibers/brushes. Social-
Emotional → Affirmations build esteem. 

• Bank Street: Self & Identity → Link hair to culture/family. Emotional Development → 
Pride and acceptance. 

• Emergent Curriculum: Responsive Inquiry → Children’s comparisons prompt 
stations. Materials → Add combs, ribbons, headwraps. 

• Waldorf: Story/Song → Tales celebrating unique features. Handwork → Yarn hair 
puppets. 

• Project-Based Learning: Salon Dramatic Play → Roles (stylist, client, receptionist). 
Driving Question → “How do we care for all hair?” 

• Academic/Skills-Based: Science → Observe/record differences. Math → Sort by 
texture/length. Language → Descriptive vocabulary. 
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Lesson Title: Exploring Cultural Holidays 

Objectives: 

• Identify holidays from multiple cultures. 

• Compare similarities/differences in celebrations. 

• Show respect for peers’ traditions. 

Curriculum Alignments 

• Montessori: Geography & Culture → Place holidays on globe/maps. Practical Life → 
Prepare simple decorations/foods. 

• Reggio Emilia: Community as Curriculum → Invite family traditions. Hundred 
Languages → Art/music/storytelling representations. 

• HighScope: KDI 8 Diversity → Learn about traditions. KDI 7 Self-Identity → Share 
personal holiday stories. 

• Creative Curriculum: Social Studies—People & How They Live → Holiday practices. 
The Arts → Create symbols/crafts. 

• Bank Street: Social Studies Core → Celebrations as community life. Emotional 
Development → Respect and curiosity. 

• Emergent Curriculum: Child-Led Focus → Follow interests in specific holidays. 
Materials → Rotating holiday stations. 

• Waldorf: Seasonal Rhythm → Link celebrations to year cycles. Storytelling → 
Seasonal tales. 

• Project-Based Learning: Mini-Holiday Fair → Stations by small groups. Driving 
Question → “What do celebrations teach us?” 

• Academic/Skills-Based: Language → Holiday vocabulary. Math → Sort symbols. SEL 
→ Respectful listening. 
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Lesson Title: Respecting Different Languages 

Objectives: 

• Notice that people speak many languages. 

• Practice simple greetings in several languages. 

• Show respect for diverse ways of communicating. 

Curriculum Alignments 

• Montessori: Language → Multilingual cards/phonetic sounds. Culture/Geography → 
Map languages to regions. 

• Reggio Emilia: Hundred Languages → Voice, song, gesture as expression. 
Community as Curriculum → Families teach greetings. 

• HighScope: KDI 19 Written Communication → Explore alphabets/symbols. KDI 8 
Diversity → Value multiple ways of speaking. 

• Creative Curriculum: Language Development → Listen/attempt words. Social 
Studies → How communities communicate. 

• Bank Street: Social Studies Core → Language connects culture. Emotional 
Development → Honor home languages. 

• Emergent Curriculum: Child-Centered → Choose words to learn. Responsive → Add 
labels around room. 

• Waldorf: Songs & Verse → Rhymes in multiple languages. Circle Time → Greeting 
rituals. 

• Project-Based Learning: “Language Corner” → Create greeting wall. Driving 
Question → “How can we welcome everyone?” 

• Academic/Skills-Based: Language Standards → Naming/using greetings. Math 
(Sorting) → Group alphabets by look. SEL → Respectful turn-taking. 
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Lesson Title: Learning About Famous Leaders 

Objectives: 

• Meet leaders (e.g., Rosa Parks, MLK Jr., Harriet Tubman, Ruby Bridges). 

• Understand contributions to justice/equality. 

• Identify leadership traits: courage, empathy, fairness. 

Curriculum Alignments 

• Montessori: History & Culture → Real biographies at child level. Grace & Courtesy → 
Practice fairness/leadership. 

• Reggio Emilia: Community as Curriculum → Connect to local helpers/heroes. 
Hundred Languages → Posters, songs, role-play. 

• HighScope: KDI 7 Self-Identity → “I can be a leader.” KDI 8 Diversity → Leaders 
worked for justice. 

• Creative Curriculum: Social Studies—People & How They Live → Contributions of 
leaders. The Arts → Create tribute art. 

• Bank Street: History/Social Studies → Leaders within society. Emotional 
Development → Empathy with struggles. 

• Emergent Curriculum: Responsive Exploration → Follow children’s questions. 
Materials → Add timelines/pictures. 

• Waldorf: Storytelling → Moral biographies in narrative form. Circle → 
Recitations/quotes. 

• Project-Based Learning: Mini-Museum → Child-made exhibits. Driving Question → 
“What makes a leader?” 

• Academic/Skills-Based: Language → Retell leader stories. Social Studies → 
Justice/fairness. SEL → Courage/respect. 
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Lesson Title: Reading Diverse Books 

Objectives: 

• Explore books featuring diverse characters/voices. 

• Build empathy and cultural understanding. 

• Discuss why representation matters. 

Curriculum Alignments 

• Montessori: Language Area → Real, meaningful texts connect to identity. 
Culture/History → Global awareness through books. Grace & Courtesy → Respectful 
dialogue. 

• Reggio Emilia: Hundred Languages → Respond via art/drama/discussion. 
Community as Curriculum → Shared readings build collective meaning. 
Documentation → Capture children’s insights. 

• HighScope: KDI 19 Reading → Active listening/engagement. KDI 8 Diversity → 
Recognize differences. Plan–Do–Review → Choose, read, discuss. 

• Creative Curriculum: Literacy—Listening & Understanding → Engage with stories. 
Social Studies—People & How They Live → Cultural connections. Social–Emotional 
→ Empathy building. 

• Bank Street: Social Studies Core (Self & Others) → Understand 
community/difference. Emotional Development → Empathy through characters. 

• Emergent Curriculum: Child-Initiated Inquiry → Questions shape themes. 
Responsive Teaching → Extend to fairness/identity. 

• Waldorf: Storytelling & Imagination → Moral/imaginative narratives. Circle Reflection 
→ Retell to cement values. 

• Project-Based Learning: Mini-Project → “Book Wall of Heroes.” Driving Question → 
“Why show people like/different from us?” 

• Academic/Skills-Based: Language—Vocabulary → New words from texts. Social 
Studies—Culture → Multiple perspectives. SEL—Empathy & Respect → Value others’ 
experiences. 
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Lesson Title: Exploring Different Abilities 

Objectives: 

• Understand that people have diverse abilities and tools. 

• Practice inclusion and respectful curiosity. 

• Identify ways to include everyone. 

Curriculum Alignments 

• Montessori: Practical Life → Explore assistive tools (models). Grace & Courtesy → 
Respectful interactions. Sensorial → Notice differences without judgment. 

• Reggio Emilia: Inclusive Projects → Stories/props normalize devices. 
Documentation → Reflect on fairness/access. 

• HighScope: KDI 7 Self & Social → Identity in community. KDI 8 Diversity → Value 
differences. KDI 10 Empathy → Perspective-taking. 

• Creative Curriculum: Social-Emotional → Kindness and acceptance. Literacy → 
Read about abilities. Social Studies → Community diversity. 

• Bank Street: Emotional Development → Respect strengths/needs. Social Studies 
Core → Roles in community. 

• Emergent Curriculum: Children’s Questions → Address devices/fairness. Inquiry → 
Problem-solve inclusion. 

• Waldorf: Storytelling → Strength-focused tales. Cooperative Play → Mixed-ability 
teamwork. 

• Project-Based Learning: “Wall of Abilities” → Showcase talents. Driving Question → 
“How can we include everyone?” 

• Academic/Skills-Based: Vocabulary → Terms for abilities/tools. SEL → Kind 
language/actions. 
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Lesson Title: Understanding Emotions and Feelings 

Objectives: 

• Identify and name common emotions. 

• Practice empathy and supportive responses. 

• Use simple strategies to manage feelings. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Emotion scripts. Practical Life → Calm 
corners/breathing. Sensorial → Recognize expressions. 

• Reggio Emilia: Hundred Languages → Draw/act feelings. Group Dialogue → Share 
perspectives. Documentation → Feelings charts. 

• HighScope: KDI 9 Emotions → Label/express. KDI 10 Empathy → Respond to others. 
KDI 7 Self-Identity → Know self. 

• Creative Curriculum: Social-Emotional → Identify/regulate feelings. Literacy → 
Books about emotions. Arts → Expressive drawing. 

• Bank Street: Emotional Development → Core focus on relationships. Social Studies 
→ Classroom community. 

• Emergent Curriculum: Child Topics → What makes us sad/happy. Responsive → 
Practice scenarios. 

• Waldorf: Story/Song → Tales that mirror emotions. Circle → Naming/gesture games. 

• Project-Based Learning: “Feelings Mural” → Shared strategies. Driving Question → 
“How do we show kindness?” 

• Academic/Skills-Based: SEL → Emotion vocabulary. Language → I-messages. Social 
Skills → Conflict repair. 
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Lesson Title: Learning About Indigenous Cultures 

Objectives: 

• Learn traditions and contributions of Indigenous peoples. 

• Show respect for cultural diversity and land connections. 

• Recognize Indigenous knowledge in daily life. 

Curriculum Alignments 

• Montessori: Geography & Culture → Maps, artifacts, traditions. Grace & Courtesy → 
Respect for peoples/lands. Art → Symbols/patterns. 

• Reggio Emilia: Environment as Teacher → Authentic materials. Inquiry → Maps, 
stories, songs. Documentation → Art/reflections. 

• HighScope: KDI 8 Diversity → Cultural understanding. KDI 21 Social Studies → 
Community/culture. KDI 23 Creative Representation → Story art. 

• Creative Curriculum: Social Studies → Traditions/ways of life. Literacy → Indigenous 
authors’ stories. Arts → Pattern-inspired work. 

• Bank Street: Self & Society → History/community identity. Emotional Development 
→ Respect and empathy. 

• Emergent Curriculum: Children’s Questions → Where/what/how people live. 
Responsive → Extend centers. 

• Waldorf: Oral Tradition → Nature-linked stories. Seasonal/Nature → Land 
stewardship. 

• Project-Based Learning: “Indigenous Story Quilt.” Driving Question → “What can we 
learn from traditions?” 

• Academic/Skills-Based: Social Studies → Cultural heritage. Literacy → 
Listening/retelling. Science → Stewardship ideas. 
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Lesson Title: Exploring Environmental Diversity 

Objectives: 

• Identify different habitats and ecosystems. 

• Appreciate biodiversity and stewardship. 

• Connect people’s lives to environments. 

Curriculum Alignments 

• Montessori: Geography → Maps/globes. Botany/Zoology → Plants/animals by region. 
Practical Life → Care for nature. 

• Reggio Emilia: Outdoor Projects → Collect/observe nature. Hundred Languages → 
Nature art. Documentation → Photos/drawings. 

• HighScope: KDI 25 Nature & Science → Explore habitats. KDI 21 Social Studies → 
People–environment links. KDI 23 Creative → Habitat models. 

• Creative Curriculum: Science → Ecosystems basics. Social Studies → Human–
environment interactions. Arts → Environmental crafts. 

• Bank Street: Social Studies Core → Environment and people. Emotional 
Development → Love for nature. 

• Emergent Curriculum: Follow interests (animals/weather). Add resources per 
curiosity. 

• Waldorf: Nature Walks/Seasonal Cycles → Rhythm of year. Watercolor → 
Landscapes. 

• Project-Based Learning: “Class Habitat Mural.” Driving Question → “Why care for 
habitats?” 

• Academic/Skills-Based: Science → Classify habitats. Math → Sort/graph animals. 
SEL → Caretaking roles. 
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Lesson Title: Understanding Stereotypes 

Objectives: 

• Define stereotype in age-appropriate terms (unfair idea about a group). 

• Practice seeing people as individuals. 

• Use respectful language that challenges bias. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Scripts for fairness. Culture → Discuss bias gently. 
Practical Life → Role-play respect. 

• Reggio Emilia: Project Work → Art that counters stereotypes. Documentation → “All 
the ways we are” displays. 

• HighScope: KDI 8 Diversity → Value uniqueness. KDI 10 Empathy → Perspective-
taking. KDI 11 Community → Fair class norms. 

• Creative Curriculum: Social Studies → Fairness/roles. Social-Emotional → 
Kindness/respect. Literacy → Stories confronting bias. 

• Bank Street: Social Studies Core → Community relationships. Emotional 
Development → Notice/reflect on bias. 

• Emergent Curriculum: Use real examples children raise. Responsive → Problem-
solve better language. 

• Waldorf: Storytelling → Myths reframed with inclusion. Circle → Fairness reflections. 

• Project-Based Learning: “Breaking Stereotypes Mural.” Driving Question → “How 
are people more than labels?” 

• Academic/Skills-Based: SEL → Bias awareness. Social Studies → Community roles. 
Language → Fair words. 
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Exploring Different Types of Homes 

Objectives: 

• Identify and compare homes from varied cultures and climates. 

• Describe features (shape, materials, location) that make homes different. 

• Express empathy for people living in different housing situations. 

• Create a representation of a home using blocks/drawing. 

Curriculum Alignments 

• Montessori: Culture/Geography → Match home types to regions on globe/maps. • 
Sensorial/Practical Life → Handle model materials (wood/cloth/ice “blocks”) to 
explore structure. 

• Reggio Emilia: Hundred Languages → Represent homes via clay, blocks, collage. • 
Community as Curriculum → Add family photos/descriptions of children’s homes to 
display. 

• HighScope: KDI 21 Social Studies → Discuss how people live in places. • KDI 24 
Science → Compare materials and their uses in shelter. 

• Creative Curriculum: Social Studies—People & How They Live → Explore 
urban/rural, cultural dwellings. • The Arts → Construct/model homes with open-
ended media. 

• Bank Street: Social Studies Core (Self & Others) → Connect personal home 
experiences to community. • Emotional Development → Build respect for diverse 
living arrangements. 

• Waldorf: Story & Imagination → Tell gentle tales of homes in seasons/lands. • 
Handwork → Simple weaving/roof “thatching” crafts. 

• Project-Based Learning: Mini-Project → “Our Neighborhood Map” with varied home 
models. • Driving Question → “How do homes fit the places people live?” 

• Emergent Curriculum: Child-Initiated Inquiry → Follow children’s questions about 
skyscrapers, tents, boats. • Responsive Teaching → Create a new center for a high-
interest home type. 

• Academic/Skills-Based: Math—Geometry/Sorting → Sort homes by 
shape/height/material. • Language—Vocabulary → Dome, apartment, yurt, igloo. • 
SEL—Empathy → Use respectful talk about differences. 
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Learning About Civil Rights Heroes 

Objectives: 

• Recognize leaders (e.g., Rosa Parks, Dr. King, Ruby Bridges) and name their 
contributions. 

• Describe fairness and courage using kid-friendly language. 

• Retell a key event from a hero’s life through art or dramatization. 

• Identify one way to practice fairness at school. 

Curriculum Alignments 

• Montessori: History/Culture → Timeline cards of heroes and events. • Grace & 
Courtesy → Practice fairness/voice during class meetings. 

• Reggio Emilia: Community as Curriculum → Link heroes to local helpers/advocates. 
• Hundred Languages → Posters, puppets, songs to express learning. 

• HighScope: KDI 7 Self-Identity → See self as capable of helping. • KDI 8 Diversity → 
Respect for differences and rights. 

• Creative Curriculum: Social Studies—Past & Present → Age-appropriate hero 
stories. • Literacy—Listening & Speaking → Discuss big ideas (justice, peace). 

• Bank Street: Social Studies Core → Place heroes within community contexts. • 
Emotional Development → Build empathy through perspective-taking. 

• Waldorf: Storytelling → Heart-centered biographies with moral focus. • Circle/Verse 
→ Affirmations about kindness and courage. 

• Project-Based Learning: Mini-Project → “Heroes Hallway” gallery with captions. • 
Driving Question → “How do brave people change rules to be fair?” 

• Emergent Curriculum: Child Questions → Pursue curiosities about buses, marches, 
schools. • Responsive Teaching → Extend centers (e.g., “peace table” role-play). 

• Academic/Skills-Based: Language → Sequencing/retell of events. • Social Studies 
→ Identify symbols (bus, sign, ballot). • SEL → Practice upstander language. 
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Exploring Cultural Music and Dance 

Objectives: 

• Listen to, move to, and identify rhythms from multiple cultures. 

• Learn and perform simple steps from at least one traditional dance. 

• Describe how music makes the body feel and move. 

• Show respect for cultural expressions during performance. 

Curriculum Alignments 

• Montessori: Music/Sensorial → Match rhythms/instruments; sound cylinders 
exploration. • Culture/Geography → Place songs/dances on world map. 

• Reggio Emilia: Hundred Languages → Express music through drawing/ribbon 
movement. • Community as Curriculum → Families share songs/dances. 

• HighScope: KDI 22 Music → Explore beat, tempo, pattern. • KDI 8 Diversity → Value 
many musical traditions. 

• Creative Curriculum: The Arts—Music/Movement → Follow/imitate movements; 
improvise. • Social Studies—Culture → Discuss origins of songs/dances. 

• Bank Street: Social Studies Core → Music/dance as community life. • Emotional 
Development → Regulate energy and express feelings. 

• Waldorf: Circle/Seasonal Songs → Pentatonic/folk movement games. • Eurythmy-
Inspired Movement → Flowing gestures for mood. 

• Project-Based Learning: Mini-Project → “World Dance Parade” showcase. • Driving 
Question → “What can we learn from how people move to music?” 

• Emergent Curriculum: Child Interest → Extend high-interest styles (drums, 
scarves). • Responsive Teaching → Create instrument-making center. 

• Academic/Skills-Based: Math—Patterning → Clap/step patterns. • Language—
Vocabulary → Rhythm, tempo, instrument names. • SEL—Cooperation → Take turns 
leading moves. 

 

 

 



Page 18 of 32 
 

©2025 Quarantine Racism Educational Services – All Rights Reserved 

Understanding Cultural Symbols and Artifacts 

Objectives: 

• Observe and name common cultural symbols/artifacts respectfully. 

• Explain, in kid-friendly terms, what a symbol can mean to a community. 

• Create a personal symbol to represent something important to self/class. 

• Practice care and respect when handling cultural items. 

Curriculum Alignments 

• Montessori: Culture → Classified cards of artifacts; three-period lessons for 
names/meanings. • Practical Life → Graceful handling/care of objects. 

• Reggio Emilia: Documentation → Caption children’s interpretations of symbols. • 
Hundred Languages → Recreate symbols via clay/printmaking. 

• HighScope: KDI 19 Language → Describe and ask questions about artifacts. • KDI 21 
Social Studies → Connect symbols to community identity. 

• Creative Curriculum: Social Studies—Culture → Explore meaning/purpose of 
items. • Arts → Design personal/class symbols. 

• Bank Street: Social Studies Core → Objects as windows into people’s lives. • 
Emotional Development → Build pride and respect. 

• Waldorf: Story/Imagery → Gentle tales explaining emblem meanings. • Handwork → 
Simple crafts echoing motifs (patterns, knots). 

• Project-Based Learning: Mini-Project → “Symbol Museum” with child-made labels. 
• Driving Question → “How do symbols help us tell who we are?” 

• Emergent Curriculum: Child Questions → Investigate high-interest items further. • 
Responsive Teaching → Invite family stories about artifacts. 

• Academic/Skills-Based: Language—Vocabulary → Symbol, artifact, tradition. • 
Math—Sorting → Group artifacts by shape/use/origin. • SEL—Respect → Scripts for 
careful, kind talk. 
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Exploring Cultural Landmarks 

Objectives: 

• Identify 3–4 landmarks and the countries/peoples connected to them. 

• Describe basic features (shape, purpose, material) of landmarks. 

• Create a simple model or drawing of a landmark. 

• Show curiosity and respect for global heritage. 

Curriculum Alignments 

• Montessori: Geography → Flag/landmark matching; map pinning. • 
Sensorial/Geometry → Notice shapes (arches, domes, pyramids). 

• Reggio Emilia: Hundred Languages → Box/blocks to model landmarks. • 
Documentation → Photo panels of builds with child quotes. 

• HighScope: KDI 21 Social Studies → Places and spaces people value. • KDI 24 
Science → Materials and structure comparisons. 

• Creative Curriculum: Social Studies—Places → Why landmarks are important. • 
Literacy → Informational texts and picture walk discussions. 

• Bank Street: Social Studies Core → Human-made environments in community life. • 
Emotional Development → Wonder/awe as pathway to care. 

• Waldorf: Story & Nature → Myths/legends surrounding places. • Handwork → 
Textured rubbings/brick prints. 

• Project-Based Learning: Mini-Project → “Postcards from the World” display. • 
Driving Question → “What stories do famous places tell?” 

• Emergent Curriculum: Child Interest → Deep-dive center on a favorite landmark. • 
Responsive Teaching → Virtual tours based on questions. 

• Academic/Skills-Based: Math—Shape/Size → Compare heights/widths visually. • 
Language—Vocabulary → Monument, arch, tower. • SEL—Respect → “We care for 
special places.” 
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Understanding Privilege and Fairness 

Objectives: 

• Define fairness in simple terms and notice when things are uneven. 

• Role-play sharing/turn-taking to make situations fairer. 

• Use kind, assertive words to ask for fairness/help a friend. 

• Reflect on one classroom action that increases fairness. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Scripts for equitable sharing/apologies. • Practical 
Life → Turn-taking systems (sand timers, name lists). 

• Reggio Emilia: Community Dialogues → Reflect on scenarios; co-create norms. • 
Documentation → “Fairness Ideas” chart with children’s words. 

• HighScope: KDI 12 Social Relations → Help/comfort peers. • KDI 15 Conflict 
Resolution → “I” messages and negotiated solutions. 

• Creative Curriculum: Social–Emotional → Identify feelings about fair/unfair. • 
Literacy → Picture books to spark fairness talks. 

• Bank Street: Social Studies Core → Classroom as democratic community. • 
Emotional Development → Perspective-taking and self-regulation. 

• Waldorf: Puppet Stories → Gentle modeling of repair/restoration. • Circle Time → 
Verses that affirm inclusion. 

• Project-Based Learning: Mini-Project → “Fair Play Toolkit” (jobs chart, signals). • 
Driving Question → “How can we make play fair for everyone?” 

• Emergent Curriculum: Child Moments → Turn real conflicts into learning stories. • 
Responsive Teaching → Adjust routines to increase access. 

• Academic/Skills-Based: SEL—Self/Relationship Skills → Assertive language. • 
Math—Data → Tally turns/jobs to visualize fairness. • Language—Vocabulary → Fair, 
share, include. 
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Learning About Colonialism and Its Impact 

Objectives: 

• Hear gentle, age-appropriate stories about land/people and change. 

• Use words like “fair/unfair” to describe past treatment of communities. 

• Show empathy by naming feelings and respectful actions. 

• Celebrate cultural resilience through art, song, or story. 

Curriculum Alignments 

• Montessori: Peace Education → Fairness, respect, and care for cultures. • 
Culture/Geography → Maps showing Indigenous lands pre/post contact (age-
appropriate). 

• Reggio Emilia: Community as Curriculum → Invite family/approved community 
stories. • Documentation → Children’s reflections on fairness. 

• HighScope: KDI 8 Diversity → Value cultures and languages. • KDI 15 Conflict 
Resolution → Practice peaceful problem-solving ideas. 

• Creative Curriculum: Social Studies—Past & Present → Simple narratives of change 
and resilience. • Arts → Create honoring symbols/crafts. 

• Bank Street: Social Studies Core → People, place, and power in community life. • 
Emotional Development → Empathy for those treated unfairly. 

• Waldorf: Storytelling → Symbolic tales of courage, guardianship of land. • Nature 
Connections → Gratitude walks/land appreciation. 

• Project-Based Learning: Mini-Project → “Respect the Land” mural. • Driving 
Question → “How do we show respect for peoples and places?” 

• Emergent Curriculum: Child Questions → Follow curiosities about maps, 
languages, foods. • Responsive Teaching → Curate resources with cultural guidance. 

• Academic/Skills-Based: Language—Vocabulary → Past, present, respect, land. • 
SEL—Empathy → Identify feelings; practice care. • Social Studies—Community → 
Recognize continuity of cultures. 
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Exploring Traditional Games and Sports 

Objectives: 

• Learn and play 2–3 traditional games from different cultures. 

• Demonstrate teamwork, turn-taking, and good sportsmanship. 

• Compare rules/equipment across games. 

• Express what was fun or challenging about each game. 

Curriculum Alignments 

• Montessori: Practical Life/Movement → Graceful movement; care of equipment. • 
Culture → Link games to countries/peoples. 

• Reggio Emilia: Hundred Languages → Chart rules with drawings/symbols. • 
Community as Curriculum → Family-led game demos. 

• HighScope: KDI 2 Movement → Gross-motor coordination. • KDI 8 Diversity → 
Respect many play traditions. 

• Creative Curriculum: Physical Development → Balance, agility, coordination. • 
Social Studies—People & How They Live → Games as culture. 

• Bank Street: Social Studies Core → Play as social connection. • Emotional 
Development → Handle winning/losing kindly. 

• Waldorf: Circle/Cooperative Games → Rhythmical, imaginative movement. • Story 
Link → Short verses to cue rules/turns. 

• Project-Based Learning: Mini-Project → “World Games Day” stations. • Driving 
Question → “What do games teach about working together?” 

• Emergent Curriculum: Child Choice → Repeat favorite games; modify rules 
together. • Responsive Teaching → Add adaptive options for access. 

• Academic/Skills-Based: Math—Counting/Scoring → Simple tallies. • Language—
Vocabulary → Tag, relay, hopscotch, queue. • SEL—Sportsmanship → Compliment 
peers. 
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Lesson Title: Celebrating Mixed Heritage 

Objectives: 

• Understand what mixed heritage means. 

• Build pride and acceptance of one’s cultural backgrounds. 

• Show empathy and interest in classmates’ family stories. 

Curriculum Alignments 

• Montessori: Cultural Studies → Explore family traditions. Grace & Courtesy → 
Respect peers’ backgrounds. 

• Reggio Emilia: Hundred Languages → Art/story to express identity. Community as 
Curriculum → Families contribute stories. 

• HighScope: KDI 8 Diversity → Recognize/celebrate differences. KDI 6 Initiative → 
Share family traditions. KDI 12 Social Relations → Empathic dialogue. 

• Creative Curriculum: Social Studies—Self, Family, Community → Family 
structures/heritage. Language/Literacy → Books on mixed heritage. 

• Bank Street: Self & Society → Identity in community context. Emotional 
Development → Pride and empathy. 

• Emergent Curriculum: Child-Initiated → Interests guide activities. Responsive → 
Add culture center items. 

• Waldorf: Storytelling → Folk tales from multiple roots. Circle → Group sharing rituals. 

• Project-Based Learning: “Our Family Stories” book. Driving Question → “What 
makes every family unique?” 

• Academic/Skills-Based: Language Arts → Descriptive storytelling. Social Studies → 
Compare families. 
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Lesson Title: Understanding Historical Injustices 

Objectives: 

• Learn age-appropriate ideas about fairness/justice in history. 

• Build empathy for people who faced unfair rules. 

• Practice peaceful problem-solving and fairness today. 

Curriculum Alignments 

• Montessori: Peace Education → Fairness/justice language. Cultural Studies → 
Gentle social history. 

• Reggio Emilia: Community as Curriculum → Reflect on fairness together. 
Documentation → Just vs. unjust drawings. 

• HighScope: KDI 8 Diversity → Discuss fair treatment. KDI 15 Conflict Resolution → 
Practice solutions. 

• Creative Curriculum: Social Studies—People & How They Live → Past experiences 
of groups. Social-Emotional → Empathy. 

• Bank Street: Self & Society → Connect past to daily life. Emotional Development → 
Right/wrong understanding. 

• Emergent Curriculum: Child-Led Reflections → Questions steer talk. Responsive → 
Use puppets/scenarios. 

• Waldorf: Storytelling → Symbolic tales of courage/fairness. Seasonal gatherings → 
Shared values. 

• Project-Based Learning: “Fairness Wall” drawings. Driving Question → “What feels 
fair?” 

• Academic/Skills-Based: SEL → Identify fair/unfair. Social Studies → History affects 
people. 
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Lesson Title: Learning About Cultural Contributions 

Objectives: 

• Discover contributions from many cultures in art, science, music, literature. 

• Appreciate diversity of innovation and creativity. 

• Create inspired works and share learning. 

Curriculum Alignments 

• Montessori: Cultural Studies → Showcase inventions/music/art. Practical Life → 
Cooking/crafts tied to cultures. 

• Reggio Emilia: Hundred Languages → Explore via art/music/play. Documentation → 
Record reflections. 

• HighScope: KDI 8 Diversity → Value varied contributions. KDI 21 Creative Arts → 
Create inspired pieces. 

• Creative Curriculum: Social Studies—Daily Life → How contributions help us. 
Literacy/Art → Read and make. 

• Bank Street: Self & Society → Link contributions to community. Emotional 
Development → Pride/respect. 

• Emergent Curriculum: Follow interests in specific contributions. Materials → Rotate 
themed centers. 

• Waldorf: Handwork/Stories → Traditional crafts/folk tales. Movement → Cultural 
dances. 

• Project-Based Learning: “Classroom Museum.” Driving Question → “How do 
cultures help the world?” 

• Academic/Skills-Based: Art/Literacy Standards → Produce/describe works. 
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Lesson Title: Promoting Allyship and Advocacy 

Objectives: 

• Define allyship (helping) and advocacy (speaking up). 

• Practice kind, supportive actions. 

• Stand up against unfair treatment safely. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Scripts for support/apology. Peace Table → Repair 
hurt feelings. 

• Reggio Emilia: Community Talks → Name unfairness and help plans. 
Documentation → Kindness pledges. 

• HighScope: KDI 15 Conflict Resolution → Role-play upstander moves. KDI 12 Social 
Relations → Practice ally behaviors. 

• Creative Curriculum: Social-Emotional → Problem-solving and advocacy. Literacy → 
Stories of helpers. 

• Bank Street: Self & Society → Community building through help. Emotional 
Development → Empathy into action. 

• Emergent Curriculum: Child-Initiated → Use real peer moments. Responsive → 
Class norms of care. 

• Waldorf: Circle Stories/Puppetry → Models of courage. Songs → “Help each other” 
refrains. 

• Project-Based Learning: Kindness Posters. Driving Question → “How can we be 
good allies?” 

• Academic/Skills-Based: SEL → Respectful language; I-statements. 
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Lesson Title: Exploring Indigenous Stories and Legends 

Objectives: 

• Listen to Indigenous stories respectfully. 

• Retell themes through art/drama. 

• Appreciate cultural teachings about nature/community. 

Curriculum Alignments 

• Montessori: Cultural Studies → Authentic stories highlight respect for nature. 

• Reggio Emilia: Hundred Languages → Retell via art/music/drama. Documentation → 
Capture interpretations. 

• HighScope: KDI 19 Reading → Engage with texts. KDI 21 Creative Arts → Dramatic 
retellings. 

• Creative Curriculum: Literacy → Listening/understanding narratives. Social Studies 
→ Recognize traditions. 

• Bank Street: Self & Society → Community identity through story. Emotional 
Development → Empathy. 

• Emergent Curriculum: Child-Driven → Follow interest in animals/symbols. 
Materials → Add props. 

• Waldorf: Oral Storytelling/Nature → Seasonal integration. Nature table → Related 
objects. 

• Project-Based Learning: “Storytelling Circle.” Driving Question → “What lessons do 
stories teach?” 

• Academic/Skills-Based: Language → Retell beginning/middle/end. 
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Lesson Title: Exploring Cultural Traditions 

Objectives: 

• Discover diverse rituals and ceremonies. 

• Show respect for heritage and practice. 

• Share personal/family traditions. 

Curriculum Alignments 

• Montessori: Cultural Studies → Artifacts/materials tied to traditions. 

• Reggio Emilia: Community as Curriculum → Family sharing events. 

• HighScope: KDI 8 Diversity → Awareness of traditions. KDI 21 Creative Arts → 
Tradition-inspired art. 

• Creative Curriculum: Social Studies—People & How They Live → Celebrations 
study. 

• Bank Street: Self & Society → Identity via family/community. 

• Emergent Curriculum: Child-Initiated → Explore meaningful traditions. 

• Waldorf: Seasonal Festivals → Nature-tied celebrations. 

• Project-Based Learning: “Festival of Traditions.” Driving Question → “How do we 
celebrate?” 

• Academic/Skills-Based: Social Studies → Compare similarities/differences. 
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Lesson Title: Learning About Environmental Justice 

Objectives: 

• Define environmental justice as fair access to clean air/water/green space. 

• Notice that harms can affect some communities more. 

• Practice age-appropriate stewardship and fairness. 

Curriculum Alignments 

• Montessori: Culture/Geography → Maps notice place differences. Practical Life → 
Recycling/plant care. 

• Reggio Emilia: Environment as Third Teacher → Clean vs. polluted inquiry jars. 
Documentation → “Healthy place” drawings. 

• HighScope: KDI 8 Diversity → Fairness lens. KDI 24 Science → Observe/compare 
water/air/plants. KDI 21 Arts → Advocacy posters. 

• Creative Curriculum: Social Studies—People & Environment → Community needs. 
Science → Cause/effect (litter vs. habitat). 

• Bank Street: Self & Society → Neighborhood well-being. Emotional Development → 
Empathy for impacted groups. 

• Emergent Curriculum: Child Questions → “Why is water dirty?” leads tests/ideas. 

• Waldorf: Nature Stories → Care for rivers/trees. Handwork → Upcycling crafts. 

• Project-Based Learning: “Keep Our Park Clean.” Driving Question → “How can we 
help our place?” 

• Academic/Skills-Based: Early Science → Sort recyclables. SEL → Fairness 
roles/turn-taking. 
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Lesson Title: Understanding Microaggressions 

Objectives: 

• Learn that small words/actions can hurt feelings. 

• Recognize, name, and respond kindly to unkind patterns. 

• Practice upstander strategies and seek help. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Kind scripts/apologies. Peace Table → Repair steps. 

• Reggio Emilia: Community Dialogues → Reflect on story scenes. Documentation → 
“Kind words” chart. 

• HighScope: KDI 12 Social Relations → Friendship skills. KDI 15 Conflict Resolution → 
I-messages. KDI 19 Language → Name feelings. 

• Creative Curriculum: Social-Emotional → Identify emotions. Language/Literacy → 
Role-play dialogues. 

• Bank Street: Self & Society → Belonging and safety. Emotional Development → 
Perspective-taking. 

• Emergent Curriculum: Playground Moments → Turn incidents into learning. 
Responsive → Practice alternatives. 

• Waldorf: Puppetry → Gentle narratives of repair/inclusion. Circle → Kindness verses. 

• Project-Based Learning: “Kindness Toolbox.” Driving Question → “What can we 
say/do to help?” 

• Academic/Skills-Based: SEL → Label/express feelings; assertive statements. 

 

 

 

 

 

 

 



Page 31 of 32 
 

©2025 Quarantine Racism Educational Services – All Rights Reserved 

Lesson Title: Exploring Different Types of Art 

Objectives: 

• Explore painting, sculpture, pottery from many cultures. 

• Appreciate diverse artistic traditions/makers. 

• Create original art and explain choices. 

Curriculum Alignments 

• Montessori: Sensorial/Art → Texture/color/form. Culture → Map artworks to places. 

• Reggio Emilia: Hundred Languages → Multi-media studios. Documentation → 
Process photos/quotes. 

• HighScope: KDI 21 Creative Arts → Try techniques. KDI 19 Language → Describe art. 
KDI 24 Science → Material properties. 

• Creative Curriculum: The Arts → Tools/techniques. Social Studies → Artists in 
community. 

• Bank Street: Self & Society → Identity through art. Cognitive → Compare styles. 

• Emergent Curriculum: Follow interest → Extend favorite station. Materials → Rotate 
media. 

• Waldorf: Watercolor/Form drawing → Rhythm/mood. Story-linked Art → Cultural 
imagery. 

• Project-Based Learning: “Our Museum” gallery. Driving Question → “How does art 
speak?” 

• Academic/Skills-Based: Literacy → Dictate artist statements. Math → 
Shapes/patterns. 
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Lesson Title: Promoting Unity and Solidarity 

Objectives: 

• Define unity (working together) and solidarity (standing with). 

• Practice teamwork, kindness, inclusion. 

• Take small actions that build a caring class. 

Curriculum Alignments 

• Montessori: Grace & Courtesy → Shared jobs. Community Meetings → Plan helpful 
actions. 

• Reggio Emilia: Co-Construction → Small-group tasks. Documentation → “We did 
this together” panels. 

• HighScope: KDI 12 Social Relations → Teamwork. KDI 15 Conflict Resolution → 
Shared plans. KDI 8 Diversity → Value differences. 

• Creative Curriculum: Social Studies—Community → Roles/helping. Social-
Emotional → Friendship skills. 

• Bank Street: Self & Society → Democratic classroom. Emotional Development → 
Empathy in action. 

• Emergent Curriculum: Respond to needs → Include left-out peers. Build rituals of 
welcome. 

• Waldorf: Circle/Seasonal Songs → Cooperative movement. Handwork → Group 
weaving/collage. 

• Project-Based Learning: “Together We Can” mural. Driving Question → “What can 
we do better together?” 

• Academic/Skills-Based: SEL → Cooperative problem-solving. Language Arts → Turn-
taking/oral sharing. 

 


